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GETTING STARTED

Barnes & Noble Press is pleased to offer the Barnes & Noble Press print platform for anyone who wants to make a profes-

sional-quality print book of his or her work for sale or for personal use. For everyone from the professional author to the 

ĆUVW�WLPH�ZULWHr, and small publishers to the individual craftsperson, the Barnes & Noble Press print platform is quick, easy 

to use and will deliver professional quality print books.

To get the most out of the Barnes & Noble Press print platform technology, your interior text and cover need to be format-

WHG�DV�SULQW�UHDG\�ĆOHV��7KLV�JXLGH�RIIHUV�IRUPDWWLQJ�LQVWUXFWLRQV�DQd recommendations that will help you make your work 

print-ready, so your printed book turns out just the way you want it to. This guide gives instructions for formatting your 

book in Microsoft Word. For instructions using Pages for Mac or Pages for iOS, see the appendix at the end of the guide.

Visit BNpress.com  to learn more.
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7R�SULQW�D�ERRN�ZLWK�%DUQHV�	�1REOH�3UHVV��\RX�ZLOO�QHHG�WR�KDYH�SULQW�UHDG\�ĆOHV�IRU�ERWK�WKH�ERRN�LQWHULRU�DQG�WKH�FRYHU��

$b%DUQHV�	�1REOH�3UHVV�SULQW�UHDG\�ĆOH�LV�D�3')��3RUWDEOH�'RFXPHQW�)RUPDW��ĆOH�IRU�WKH�FRYHU��DQG�HLWKHU�D�3')�RU�0LFUR-

soft Word document for the interior, with certain formatting rules applied during creation. 

7KLV�IRUPDWWLQJ�JXLGH�ZLOO�SURYLGH�WLSV�RQ�KRZ�WR�PDNH�VXUH�\RXU�ERRN�DQG�FRYHU�ĆOHV�DUH�UHDG\�IRU�RXU�SULQWHUV�

What is a Print-Ready File? 

Whether you’re a major book publisher or an independent author, the printing process starts the same way—with a print-ready 

PDF for the cover and either a PDF or MS Word document for the interior. 

3OHDVH�QRWH�WKDW�MXVW�EHFDXVH�D�ĆOH�KDV�D��3')�RU�D��'2&�H[WHQVLRQ�WKDW�GRHV�QRW�PHDQ�LW�LV�QHFHVVDULO\�êSULQW�UHDG\�ë���

Most authors write their books in a word processing software program, such as Microsoft Word, WordPerfect, Mac Pages, 

or Google Docs. These programs are perfect for the writing process, but may not be ideal for printing because what is 

shown on screen may not translate faithfully to the printer. Spacing and page breaks may differ, for example. A document 

that looks tidy online might appear awkward when printed, so if you’re uploading an MS Word document as your interior, 

be sure to double check your interior digital proof. Remember, too, that we don’t accept interior documents in WordPerfect, 

Mac Pages, or Google Docs.

<RX�PD\�ZDQW�LQVWHDG�WR�FKRRVH�D�SULQW�UHDG\�3')�ĆOH�IRU�\RXU�LQWHULRU��ZKLFK�ZLOO�WUDQVODWH�H[DFWO\�ZKDWèV�RQ�VFUHHQ�WR�WKH�

SULQWHU��1R�PDWWHU�WKH�FRPSXWHU�RU�PDFKLQH��D�3')�ZLOO�SULQW�WKH�VDPH�ZD\�EHFDXVH�LWèV�LQ�D�êORFNHG�IRUPDW�ë�+DYLQJ�D�ORFNHG�

formatted document is great for knowing exactly how your book will look when it’s printed. 

A print-ready PDF does have limitations, though. There are a few rules to make sure the PDF version of your manuscript re-

sults in a good-looking book. We’ll walk you through the steps for converting from a word document to a PDF if you choose 

to do so, and help you avoid the pitfalls of these limitations. 

For the more adventurous, there are design layout programs like InDesign from Adobe that provide more advanced 

IHDWXUHV�DQG�ĆQHU�FRQWUROV�IRU�SDJH�GHVLJQ��,W�LV�DOVR�SRVVLEOH�WR�FUHDWH�3')V�IURP�WKHVH�SURJUDPV��)RUbPRUH�

LQIRUPDWLRQbDERXW�FRQYHUWLQJ�,Q'HVLJQ�ĆOHV�LQWR�3')V��SOHDVH�YLVLW�http://helpx.adobe.com/indesign.html.

BOOK FILE REQUIREMENTS
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Preparing your text document is an important step in get-

ting your manuscript ready for print. To help you create a 

SULQW�UHDG\�ĆOH��ZHèOO�FRYHU�VRPH�EDVLF�ERRN�VWUXFWXUH�DQG�

design elements that you need to address.

Proofread and Spell-Check 
5HDG�RYHU�\RXU�PDQXVFULSW�IURP�VWDUW�WR�ĆQLVK��NHHSLQJ�DQ�

eye out for grammatical or other errors that might have 

crept in while writing. Use your word processor’s spell-

check feature to check for typographical errors or misspell-

ings. It’s often helpful to have a trusted friend or colleague 

read your work with a fresh eye.

Spacing and Text Placement
In general, it’s best to use paragraph styles to control the 

spacing before and after paragraphs and the insertion of 

page breaks in a text.

Using Hard Returns
8VH�êKDUG�UHWXUQVë�RU�WKH�(QWHU�NH\�IRU�SDUDJUDSK�EUHDNV�

only. DO NOT use a series of hard returns to indicate a new 

page. Using hard returns to indicate a page break will result 

in a messy book page when printing. Instead, use the page 

break or section break option in your word processor for 

this type of break. 

.HHSLQJ�7H[W�5HćRZODEOH
0RVW�ZRUG�SURFHVVRUV��LQFOXGLQJ�:RUG��DUH�UHćRZDEOH��

PHDQLQJ�WKH\�DXWRPDWLFDOO\�ćRZ�ZRUGV�IURP�OLQH�WR�OLQH��

making adjustments automatically when the user changes 

the window size. For the Barnes & Noble Press print plat-

IRUP��EH�VXUH�WR�NHHS�WH[W�UHćRZDEOH��LQ�PRVW�ZRUG�SURFHV-

sors, this is automatic. Plus, if your document’s paragraph 

VW\OHV�DUH�VHW�WR�IXOO�MXVWLĆHG��ćRZLQJ�WKH�WH[W�RI�FRPSOHWH�

lines from the left margin to the right, as this paragraph 

does), hyphenation will be automatic. This will allow you to 

freely enter and edit text without manually breaking a word 

at the end of a line of text. 

Using the Space Bar
As a general rule, do not use the space bar to indent 

paragraphs or adjust the indentation or placement of other 

text elements. Use paragraph styles to automatically indent 

paragraphs, or use the Tab key. Do not use multiple spaces 

to indent paragraphs because it will not translate properly 

to a printed page. Also, if you want to center text, use the 

text-centering tool. Do not use the space bar to move lines 

visually across the page. These improperly used spaces will 

cause inconsistencies in layout when going through your 

ĆQDO�IRUPDWWLQJ�SURFHVV�

Book Layout and Elements
As you prepare your book, it’s helpful to keep in mind the 

following conventions used in book publishing.

Book Pages and Page Spreads
We count two book pages (e.g., page 1 and page 2) on a single 

sheet of paper. When we talk about a page in a book, we 

mean only one side of the paper. Each sheet of paper holds 

two pages: the front and the back. If there are 200 pages in a 

book, there are only 100 sheets of paper.

A spread is a book layout with two facing pages.

Odd-number pages appear on the right side of a spread. 

Even number pages appear on the left. Page 1 always begins 

on the right side, and establishes the pattern of odd/even 

used for the rest of the book.

PRE-PRESS MANUSCRIPT 
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The Book Block
In publishing, the collection of all the pages between the 

FRYHUV�LV�NQRZQ�DV�WKH�êERRN�EORFN�ë�:LWKLQ�WKH�ERRN�EORFN�

itself, there are usually three sets of pages:

ï The Front Matter

 The front matter includes the title page, the copyright 

page, a table of contents, and perhaps other elements, 

such as a foreword, a preface, and an epigraph. 

ï The Core Matter

 The core matter consists of the main content of a book: 

the narrative in a novel, the poems in a poetry collection, 

the essays in an essay collection, and so on.

ï The Back Matter

 The back matter consists of all the content that follows 

the core matter. This could include an epilogue, an after-

ZRUG��DFNQRZOHGJHPHQWV��D�VKRUW�SURĆOH�RI�WKH�DXWKRU��

and an index.

Front Matter
Front matter is the material in the front of the book, before 

the book narrative begins. Front matter is up to your 

personal preference, though it’s good to at least have a title 

SDJH�EHIRUH�WKH�ĆUVW�QDUUDWLYH�SDJH��([FHSW�IRU�WKH�7DEOH�

of Contents, these elements are typically one page each. In 

typical order of appearance:

Each of these elements is described below.

Title Page
The title page appears on the right and presents the full title 

of the book and the author’s name. 

Copyright Page
If your print book is for personal use, you do not need an 

ISBN to print your book using Barnes & Noble Press. If your 

print book is for sale, however, you must have an ISBN and 

should list it on the copyright page.

 Under U.S. copyright law, your self-published work is 

protected as soon as you put pen to paper. Copyright is 

based on your creative authorship and is not dependent 

on any formal agreement with a book publisher or self-

publishing company, although registration with the U.S. 

 &RS\ULJKW�2IĆFH�LV�EHQHĆFLDO��

 Copyright registration allows you a higher level of security 

DQG�FRQĆGHQFH�ZKHQ�LW�FRPHV�WR�SURWHFWLQJ�\RXU�ZRUN��

When you register your work with the U.S. Copyright 

RIĆFH��\RX�FUHDWH�D�SXEOLF�UHFRUG�RI�\RXU�DXWKRUVKLS��(YHQ�

though you are protected the moment you start writing, 

\RXèOO�KDYH�WR�UHJLVWHU�\RXU�ZRUN�ZLWK�WKH�&RS\ULJKW�2IĆFH�

� WR�EH�RIĆFLDOO\�UHFRJQL]HG�DV�WKH�FRS\ULJKW�KROGHU�LQ�D�FRXUW�

of law. The use of the copyright notice is the responsibility 

RI�WKHbFRS\ULJKW�RZQHU���)RU�PRUH�LQIRUPDWLRQ�VHH�

 http://www.copyright.gov/circs/circ01.pdf

You do not need an ISBN to print your book using the 

Barnes & Noble Press print platform. However, if your book 

does have an ISBN, you should list it.

Dedication
If an author wants to dedicate the book to a person or group 

of people, that dedication usually appears on its own odd-

numbered page. The dedication itself is often centered and 

set in italic like so:

To Mary, as always

Table of Contents
The table of contents follows next. Microsoft Word and 

other word processors include tools for automatically gen-

HUDWLQJ�D�WDEOH�RI�FRQWHQWV�WR�HQVXUH�LW�DFFXUDWHO\�UHćHFWV�

your latest changes to the document.

Epigraph
An epigraph is a quotation or group of quotations that the 

author feels set the tone for the book that follows. Like 

dedications, epigraphs might be centered on the page and set 

in italics. Quotations should always be attributed.

Optimism is the faith that leads to achievement.

                      —Helen Keller

Preface
A preface is an introduction written by the author of the book.

Foreword
A foreward is an introduction usually written by someone 

RWKHU�WKDQ�WKH�DXWKRU�RI�WKH�ERRN��,Q�QRQĆFWLRQ��WKH�IRUH-

ZRUG�PLJKW�EH�ZULWWHQ�E\�DQRWKHU�H[SHUW�LQ�WKH�VDPH�ĆHOG�DV�

the author.

ï Title page 

ï Copyright page

ï Dedication page

ï Table of contents

ï Epigraph 

ï Preface

ï Foreword

PRE-PRESS MANUSCRIPT 
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The Core Matter
Chapter Breaks
Many books contain chapter breaks, but it’s not a  

requirement. If your manuscript does have chapter breaks, 

think about how they visually appear on the page. 

Usually chapter titles appear about a third of the way down 

the page. In your word processor, you might want to use a 

FRQVLVWHQW�&KDSWHU�7LWOH�SDUDJUDSK�VW\OH�WKDW�VSHFLĆHV�D�VHW�

number of inches or points to make the  

WLWOH�DSSHDU�DW�D�VSHFLĆF�SODFH�RQ�WKH�SDJH��8VH�SDUDJUDSK�

styles rather than a series of hard returns to position titles 

and create blank space on a page.

The picture below shows how chapter breaks and  

chapter titles are typically formatted.

Setting Up Chapter Breaks and Chapter Titles 
using Microsoft Word
ï� Starting on a New Page, click the Page Layout tab and 

then click Breaks. Click the type of section break that 

you want to use. You can also choose to have your chap-

ters start on a new right page by choosing  

Section Break: Odd Page. 

ï� &KDSWHU�ê6LQNë�å�7KH�FKDSWHU�WH[W�VWDUWV�GRZQ�LQ�WKH�

middle or lower third of the page. This is usually done if the 

chapter starts on a right hand (or odd) page. A good way to 

FUHDWH�D�&KDSWHU�6LQN�LV�WR�GHĆQH�D�&KDSWHU�7LWOH�SDUDJUDSK�

VW\OH�WKDW�VSHFLĆHV�WKH�DPRXQW�RI�VSDFLQJ�\RX�ZDQW�WR�DS-

pear before the title and use that consistently throughout 

your book. Use this approach rather than pressing return 

multiple times to create the sink.

Back Matter
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Back matter is the material in the back of the book, after 

the last page of the narrative text. Like front matter, not all 

books have or require back matter.

In typical order of appearance, back matter can include the 

following:

ï� (SLORJXH�

ï� $IWHUZRUG�

ï� (QGQRWHV�

ï� %LEOLRJUDSK\

ï� *ORVVDU\

ï� ,QGH[

ï� $XWKRU�ELRJUDSK\

Epilogue
An epilogue is a brief continuation of the main narrative or 

content of the book.

Afterword
An afterword is commentary on the book, usually written 

by someone other than the book’s author. An afterword 

might describe the historical context in which the book 

was written or provide some other kind of useful back-

ground material.

Endnotes
If the book included numbered reference notes that were 

not formatted as footnotes, they can appear in an endnotes 

section at the back of the book.

Bibliography
,Q�QRQĆFWLRQ�ERRNV��WKH�ELEOLRJUDSK\�OLVWV�DOO�WKH�VRXUFHV�

that the author or authors consulted for their work.

Glossary
$�JORVVDU\�GHĆQHV�VSHFLDO�RU�XQXVXDO�WHUPV�LQ�D�ERRN�

Index
An index is an alphabetical list of important topics from the 

book, along with citations of all the pages on which those 

topics appear.

Author Biography
$�EULHI�ê$ERXW�WKH�$XWKRUë�VHFWLRQ�PLJKW�RIIHU�D�EULHI�ELRJUD-

phy of the author.



This section provides tips for laying out a Microsoft Word 

document to make an aesthetically pleasing and profes-

sional looking book.

3ODQQLQJ�WKH�ZD\�D�PDQXVFULSW�DSSHDUV�RQ�WKH�Ć[HG�ERRN�

SDJH�LV�FDOOHG�êIRUPDWWLQJ�ë�RU�OD\RXW�DQG�GHVLJQ��:HOO�

thought-out design elements make your book  

aesthetically pleasing and easier for the reader to follow.  

)RU�D�TXDOLW\��ĆQLVKHG�SURGXFW��SD\�FORVH�DWWHQWLRQbWR�

the consistency of your design. If you have a chapter 

heading style, use that style for each chapter header 

WKURXJKRXW�WKH�ERRN��,I�\RX�VWDUW�\RXU�FKDSWHUbKDOIZD\�

down the page, start all the chapters halfway down 

WKH�SDJH��2QFH�\RX�KDYH�ĆQLVKHG�GHVLJQLQJ�WKH�ORRN�

of your book, make sure you go back and review the 

whole book for consistency in your design elements.

Format
You can choose whether you want a hardcover or paperback 

ERRN��(DFK�IRUPDW�KDV�LWV�RZQ�VSHFLĆFDWLRQV�WR�FRQVLGHU��

Whichever format you choose you will need to provide a 

print-ready PDF of the entire cover including spine, or the 

IURQW��VSLQH��DQG�EDFN�FRYHU�ĆOH��<RXU�FRYHU�ĆOHV�ZLOO�OLNHO\�

have an image, title, author name, and any other text ele-

ments you choose to include. If your print book is for sale, 

it will need to include a barcode. For more detailed instruc-

WLRQV�RQ�KRZ�WR�IRUPDW�\RXU�FRYHU�ĆOHV�VHH�SDJH����

Hardcover
If you choose a hardcover format, you can select to print 

with a Dust Jacket or with a Printed Case. 

ï� 'XVW�-DFNHW��WKH�GXVW�MDFNHW�ZUDSV�DURXQG�WKH�FDVH��<RXU�

FRYHU�ĆOH�ZLOO�EH�SULQWHG�RQWR�WKH�UHPRYDEOH�GXVW�MDFNHW�

RI�\RXU�ERRN��1RWH�WKDW�WKH�ćDSV�RI�\RXU�GXVW�MDFNHW�

cover will be blank.

ï�� 3ULQWHG�&DVH��WKH�KDUG�SDUW�RI�D�KDUGFRYHU�ERRN�LV�FDOOHG�

D�êFDVH�ë�3ULQWHG�&DVH�PHDQV�\RXU�FRYHU�ĆOH�ZLOO�EH�

printed directly onto the paper used to wrap the case of 

your book. 

Paperback
ï�� The Barnes & Noble Press print platform uses a stan-

dard paperback form with a glued spine binding. This 

type of binding is sometimes called perfect binding, 

creating a perfect-bound book.

Finish
ï�� Note that all covers are available in matte only, not 

glossy. Also, if you print in black and white, your cover 

will automatically be printed in color.

Paper
For black and white printing, we offer 50# white 

paper stock or 60# cream paper stock. We also 

offer premium color 70# white paper stock.

Page Count and Trim Size
It’s important to consider the physical dimensions of 

your book when formatting your document. The height 

DQG�ZLGWK�RI�D�ERRN�LV�FDOOHG�LWV�êWULP�VL]H�ë��3DJH�FRXQW�

and trim size are closely related because the physical 

dimensions of the trim size affect the page size and 

therefore how many words will fit on a page (i.e., the 

smaller the page, the longer the page count). 

Page Count
The machines we use to print books have minimum and 

maximum page counts: 

ï�� 0LQLPXP�3DJH�&RXQW�����SDJHV

ï�� 0D[LPXP�3DJH�&RXQW������SDJHV

NOTE: The page count includes all the pages of your interior 

text, regardless of which page actually is marked page 1.  

LAYOUT AND DESIGN
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LAYOUT AND DESIGN

Trim Sizes
7KH�PRVW�SRSXODU�WULP�VL]HV�IRU�ĆFWLRQ�DQG�QDUUDWLYH�QRQ�ĆFWLRQ�DUH�VKRZQ�EHORZ�
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Depending on the type of book you are printing, there are other trim size options available.  

The trim sizes below are optimal for photo books, cookbooks, and children’s books.

7” x 10”
(17.78 x 25.4 cm)

7.5” x 9.25”
(19.05 x 23.5 cm)

8” x 10”
(20.32 x 25.4 cm)

8.5” x 8.5”
(15.6 x 23.39 cm)

5” x 8”
(12.7 x 20.32 cm)

5.5” x 8.5”
(13.97 x 21.59 cm)

6” x 9”
(15.24 x 22.86 cm)

Below is a chart of the trim sizes, formats and text colors we offer: 

Trim Size Page Page Formats Printed Case Printing Paper Color
 Count Count  or Dust Jacket Color
 Min Max                     

�ë�[��ë� ��� ���� 3DSHUEDFN� � %	:� %	:��:KLWH�������&UHDP���������������

���ë�[����ë� ��� ���� 3DSHUEDFN�+DUGFRYHU� %RWK� %	:�&RORU� %	:��:KLWH������&UHDP����� 

      Premium Color: White 70#                  

�ë�[��ë� ��� ���� 3DSHUEDFN�+DUGFRYHU� %RWK� %	:�&RORU� %	:��:KLWH������&UHDP�����

      Premium Color: White 70#                  

���ë�[�����ë 40 800 Paperback  B&W B&W: White 50# /Cream 55#            

�ë�[���ë� ��� ���� 3DSHUEDFN�+DUGFRYHU� 3ULQWHG�&DVH� %	:�&RORU� %	:��:KLWH������&UHDP�����

      Premium Color: White 70#                 

�ë�[���ë� ��� ���� 3DSHUEDFN�+DUGFRYHU� 3ULQWHG�&DVH� %	:�&RORU� %	:��:KLWH������&UHDP�����

      Premium Color: White 70#                   

���ë�[����ë� ��� ���� 3DSHUEDFN� � &RORU� 3UHPLXP�&RORU��:KLWH��������������������



5” x 8”
(12.7 x 20.32 cm)

5.5” x 8.5”
(13.97 x 21.59 cm)

6” x 9”
(15.24 x 22.86 cm)



7.5” x 9.25”
(19.05 x 23.5 cm)

8.5” x 8.5”
(15.6 x 23.39 cm)



7” x 10”
(17.78 x 25.4 cm)

8” x 10”
(20.32 x 25.4 cm)



How to Set Paper Size using Word on a Mac 
Choose Page Setup…under File from the top navigation bar. Under Paper Size choose Manage 

&XVWRP�6L]HVðDQG�WKHQ�W\SH�LQ�\RXU�VSHFLĆF�WULP�VL]H�GLPHQVLRQV��

Formatting for Trim Size
Once you’ve decided on your desired trim size, you need to designate those measurements in your document.  

6HWWLQJ�WKH�GRFXPHQW�SDSHU�VL]H�ZLOO�WHOO�WKH�SULQWHU�KRZ�ELJ�WR�PDNH�\RXU�ERRN�SDJH�VR�LW�ĆWV�ZLWK�\RXU�GHVLUHG� 

trim size. It’s very important to set these measurements.

How to Set Paper Size using Word on a PC 
Click the Page Layout tab and then click on the lower right button of the Page Setup  

section to open the complete dialog box:

12 The Barnes & Noble Press Print Platform Formatting Guide

LAYOUT AND DESIGN

Click the Paper tab, select the custom size option 

and enter your desired measurements. In the drop-

GRZQ�PHQX�QH[W�WR�ê$SSO\�WRë��PDNH�VXUH�WR�FOLFN�RQ�

ê:KROH�'RFXPHQWë�WR�DSSO\�WKLV�VL]H�WR�WKH�ZKROH�

document.



Margin Size 
Margin settings in your book establish the white space that appears around the text. After you’ve set your document/paper size, 

you will need to set the margin size. You want to have enough white space so that the text doesn’t run off the book page. The stan-

GDUG�PDUJLQ�VHWWLQJ�LV�����ë�RQ�HDFK�VLGH�RI�WKH�WH[W�H[FHSW�IRU�WKH�LQVLGH�PDUJLQ�ZKLFK�VKRXOG�EH����ë��

0DUJLQ�VHWWLQJV�DUH�VHW�IURP�WKH�HGJH�RI�WKH�SDSHU�VL]H�\RX�LQGLFDWHG�VR�LWèV�LPSRUWDQW�WR�VHW�WKH�GRFXPHQW�SDSHU�VL]H�ĆUVW�

Setting Margin Size using Word on a PC 
Click the Page Layout tab and then click on the lower right button of the Page Setup section to 

open the complete dialog box. Click the Margins tab and enter your desired margin measure-

PHQWV��&KRRVH�\RXU�RULHQWDWLRQ�DQG�WKHQ�VHOHFW�0LUURU�0DUJLQV�LQ�WKH�ê3DJHVë�VHFWLRQ��&OLFN�

OK to apply these settings to the document. 

Setting Margin Size using Word on a Mac
Click on Layout from the navigation bar, then click on Margins. Choose Custom Margins...to set 

your margins and mirror margins in the same place. 
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Gutter
When a book page gets bound, the inner edges of the book 

pages are glued together. These inner margins are often 

FDOOHG�WKH�êJXWWHU�ë�DQG�LWèV�LPSRUWDQW�WR�OHDYH�HQRXJK�URRP�

on the inside margin so that text doesn’t fall into the gutter. 

The longer the book, the thicker the book, and therefore, 

the bigger the inside margins should be.  

ï�� +RZHYHU��DV�ORQJ�DV�\RX�VHW�WKH�RXWVLGH�PDUJLQV�WR�����ë�

DQG�WKH�LQVLGH�PDUJLQ�WR����ë��WKHQ�\RX�'2�127�QHHG�WR�

VHW�DQ�DGGLWLRQDO�JXWWHU��6HW�JXWWHU�WR�����ë

ï�� ê0LUURU�PDUJLQVë�LV�XVXDOO\�WKH�EHVW�IRUPDW�RSWLRQ��

Images
If you’re including images in your document, it’s important 

that they be high-resolution images, so that they print crisp 

and clear. We recommend saving images at 300 DPI (dots 

per inch) or higher.

Note that the color on your computer screen will not neces-

sarily match the color of your printed pages. Your computer 

screen shows projected RGB color (Red, Green and Blue), 

and the printed books show CMYK color (Cyan, Magenta, 

Yellow and Black). 

Before printing a large numbers of copies, be sure to look 

RYHU�\RXU�SULQW�UHDG\�ĆOH�WR�HQVXUH�WKDW�WKH�LPDJHV�DSSHDU�

how you want them, or print out one copy of your book to 

start.

A Checklist for Images
Here is a checklist to make sure your images meet print-

ready requirements:

ï�� ,PDJHV�PXVW�EH�DW�OHDVW�����'3,�WR�EH�FRQVLGHUHG�

print quality. 

ï�� )RU�IXOO�EOHHG�LQWHULRU�LPDJHV��LPDJHV�WKDW�SULQW�WR�WKH�

HGJH�RI�WKH�SDJH���D�JRRG�EOHHG�YDOXH�LV�������ë�7KH�EOHHG�

value is the margin beyond the edge of the page to which 

the image should extend in order to ensure that printing 

consistently reaches the edge of the page.

ï�� ,PDJHV�PXVW�EH�HPEHGGHG�LQWR�WKH�GRFXPHQW�DQG�QRW�

EH�D�UHIHUHQFH�OLQN��7KH�ĆOH�VKRXOG�LQFOXGH�HYHU\WKLQJ�

QHHGHG�WR�SULQW�WKH�ĆOHæLPDJHV��IRQWV��DQG�WH[W�

ï�� 5HPHPEHU�WKDW�\RX�PXVW�KDYH�WKH�ULJKWV�WR�DOO�RI�WKH�

images you use.

ï�� ,I�\RXèUH�XVLQJ�3KRWRVKRS��,Q'HVLJQ�RU�,OOXVWUDWRU��

make sure your images are flattened to analog. Analog 

means that an image with multiple layers—designed 

using the above programs—has been condensed into a 

single layer. For instructions on flattening images see 

below. 

Converting a Multi-layer Image to Analog when 
using Photoshop, InDesign or Illustrator
To retain the richness and depth of a multi-layer image that 

\RX�QHHG�WR�VDYH�DV�D�ćDWWHQHG��DQDORJ�YHUVLRQ�IRU�\RXU�SULQW�

UHDG\�3')��\RXèOO�QHHG�WR�VDYH�WKH�LPDJH�DV�D��SVG�RU��SQJ�ĆOH��

On a PC, you can click Control + A to select the entire im-

age, press Control + Shift + C to copy the selection as a single 

layer, and then press Control + V to paste the selection back 

LQWR� \RXU�ZRUNVSDFH��7KDW�ZLOO� JLYH�\RX� WKH�ćDWWHQHG� OD\HU�

you want, with the original layers still intact underneath.

Inserting Images Using Microsoft Word
To insert an image from a saved computer file or insert 

clip art, go to the Insert menu from the top navigation bar. 

Select Picture to insert an image from your computer or 

Clip Art to insert stock photography.  With the image se-

lected, go to the Format menu and select Format Picture. 

You can then format your image accordingly. 

Typeface/Fonts
Choosing the right typeface/font for your book is based on 

personal preference. However, certain fonts are better for 

reading and certain fonts are better for design. Whichever 

font you choose, it’s important to think about how the 

reader will consume it.

 When talking about fonts, you will often hear the  

WHUPV�êVHULIë�DQG�êVDQV�VHULI�ë�$�VHULI�W\SHIDFH�KDV�OLWWOH�

lines at the terminus of each stroke. A sans serif  

typeface does not. Typically, serif fonts are considered 

more readable and are good for the body text of your 

book. If you want to use sans serif fonts, they are  

typically better for chapter or section headers.
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Typefaces
Here are examples of popular serif typefaces, all set in 

eleven points. (Point sizes are explained below.)

�� *DUDPRQG

� 7KH�TXLFN�EURZQ�IR[�MXPSHG�RYHU�WKH�OD]\�GRJ�

� Palatino
 The quick brown fox jumped over the  

lazy dog.
� Times New Roman
 The quick brown fox jumped over the lazy dog.
� Century
 The quick brown fox jumped over the lazy dog.
 Here are examples of popular sans serif typefaces, also 

set in eleven points.

� Arial
 The quick brown fox jumped over the  

lazy dog.
� Helvetica
 The quick brown fox jumped over the  

lazy dog.
� Verdana
 The quick brown fox jumped over the lazy 

dog.

Font Size
The size of type is important for making sure your book is 

easy to read. Type is measured in points. Generally, keeping a 

font between 10 and 12 points for the body will result in an 

easily legible book. Feel free to experiment with large type 

sizes for chapter or section headings.

Line Spacing
7\SLFDOO\��OLQH�VSDFLQJ�LV�VHW�EHWZHHQ�êVLQJOH�VSDFLQJë�DQG�

ê����OLQHVë�WR�PDNH�WH[W�OHJLEOH�ZLWKRXW�OHDYLQJ�WRR�PXFK�

white space between lines.  You can also specify line spacing 

in points. Generally, it’s best to have line spacing for the 

main text be at least 2 points larger than the font size. For 

example, if you’re using 11 point type, try setting the line 

spacing or line height to 13, 13.5, or 14 points.

Pagination
Pagination means numbering the pages in your book. To 

KHOS�\RXU�UHDGHUV�ĆQG�WKHLU�SODFH�LQ�\RXU�ERRN��ZH�UHFRP-

mend using pagination. 

Page numbers typically appear in the lower left corner of 

even-numbered pages and the lower right corner of odd-

numbered pages, but you can place them elsewhere if you’d 

like. Explore the Pagination tool in your word processor to 

discover which options are available to you.

Some publishers use lowercase Roman numerals to number 

pages in the front matter and then switch to traditional 

Arabic numerals for the main narrative. 

If your book includes front matter, you have the choice of 

QXPEHULQJ�WKH�ĆUVW�SDJH�RI�\RXU�QDUUDWLYH�SDJH���RU�\RX�

FDQ�GR�DV�VRPH�SXEOLVKHUV�GR�DQG�DVVLJQ�WKH�ĆUVW�SDJH�RI�

narrative the number it would have if you were numbering 

all pages, including the front matter, sequentially. Thus, front 

matter might run from page iii to page xxi, and the main nar-

rative might start on page 23.

The picture below shows how front matter such as a preface 

might be assigned page numbering in lowercase roman 

type. The main narrative begins with the next sequential 

number but set in Arabic numerals. You might want to look 

at how publishers you admire have assigned page numbers 

in their books to get an idea of how you want to assign page 

numbers in yours.
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Other Layout Elements to Consider
It’s easy to spend a lot of time trying to perfect your layout. Here are just a few more elements to consider as you work on 

\RXU�ĆQDO�GHVLJQ�

Running Headers/Running Footers
Running heads/running feet are the elements at the top or bottom of book pages. Typically, these sections can include things like 

the author’s last name, the book title, the title of the chapter, etc.  A common running head is the page number.

Applying Running Heads/Footers using Word on a PC
Open the Page Setup dialog box. Click the 

Layout tab and you will be able to adjust 

the layout, section start, alignment, and set 

values for headers and footers.

ï� &KRRVH�KRZ�\RX�ZDQW�D�QHZ� 

section to start — Continuous, New 

Page, Odd Page or Even Page.

ï� &KRRVH�WR�VHW�GLIIHUHQW�WH[W�RQ�RGG�

DQG�HYHQ�SDJHV��RU�D�GLIIHUHQW�ĆUVW�

page. Then set the values for the 

header and footer.

ï� &KRRVH�WKH�YHUWLFDO�DOLJQPHQW�IRU�

the section (this is usually set to 

Top). Select if you want to use these 

VHWWLQJV�IRU�ê7KLV�VHFWLRQë�RU�ê7KH�

ZKROH�GRFXPHQWë�DQG�WKHQ�FOLFN�2.�

to apply.

Applying Running Heads/Footers using Word on a Mac
You can set the headers and footers of your book from the Document Elements section at the 

top of your toolbar. 
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Widows and Orphans
In typesetting, a widow is the last line of a paragraph when 

it appears by itself at the top of a page. The image below 

shows an example of a widow.

 

$Q�RUSKDQ�LV�HLWKHU�WKH�ĆUVW�OLQH�RI�D�SDUDJUDSK� 

appearing by itself at the bottom of the page, or a  

word or two appearing as the last line of a paragraph  

or as a line at the top of a page. The image below  

shows an example of an orphan. 

Traditionally, typesetters would try to avoid widows  

and orphans, because the white space around them  

can look awkward.

Microsoft Word features an on/off control for limiting wid-

ows and orphans. Go to Paragraph, then the Line and Page 

Breaks tab. Make sure the Widow/Orphan control check 

box is selected. 

Full Justification/Rag Right
Paragraph alignment is up to your personal preference. 

Books are often designed so that the left and right paragraph 

OLQHV�DUH�ćXVK�WR�WKH�PDUJLQ�RU�IXOO\�MXVWLĆHG��

When the right side of the text lines are allowed to  

DSSHDU�MDJJHG��WKLV�LV�FDOOHG�êUDJJHG�ULJKWë�RU�êUDJ�ULJKW�ë�

)LFWLRQ�DQG�QRQ�ĆFWLRQ�DUH�XVXDOO\�W\SHVHW�IXOO\�MXVWLĆHG��EXW�

much poetry is typeset ragged right. 

7R�VHW�\RXU�WH[W�WR�IXOO\�MXVWLĆHG�JR�WR�WKH�+RPH�PHQX�IURP�

the top navigation bar then go to the Paragraph section.  Se-

lect All to highlight your entire text then click on the button 

that says Justify when you hover over it.  

Crop Marks 
Crop marks are patterns of lines indicating where to trim 

�FURS��WKH�SDSHU�WR�D�VPDOOHU�GRFXPHQW�VL]H��<RXU�ĆOH�GRHV�

not need crop marks for the Barnes & Noble Press print 

platform, so please remove any crop marks before submit-

WLQJ�\RXU�ĆOH�IRU�SULQWLQJ�
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Now that your manuscript is formatted properly, you may 

want to save it as a PDF or you may want to leave as is in MS 

Word. If you do choose to convert it to a PDF, make sure to 

VDYH�\RXU�ĆQDO�PDQXVFULSW�DV�D�ZRUG�SURFHVVLQJ�ĆOH�WRR��MXVW�

in case you need to edit something later. 

If you have installed a free PDF conversion tool like Adobe 

Acrobat on your computer, saving a Word document as 

a print-ready PDF is fairly straightforward, but there are 

some important steps you’ll need to take to create a type 

of PDF that’s compatible for the book printer. These steps 

include:

ï�(QVXULQJ�\RXU�:RUG�ĆOH�LV�QRW�HQFU\SWHG�

ï�Ensuring your fonts are embedded.

If you want to keep your document in Word, you will also 

need to ensure these two points are followed.

 If you do not have Adobe Acrobat or another PDF  

conversion program installed on your computer, you  

can use an online PDF-conversion service available  

at www.adobe.com/createpdf.

Removing Encryption
0DNH�VXUH�WKHUH�LV�QR�HQFU\SWLRQ�RQ�DQ\�DVSHFW�RI�WKH�ĆOH��

including the images. Encryption generally means password 

SURWHFWLRQ��VR�MXVW�EH�VXUH�WKDW�QRQH�RI�\RXU�ĆOHV�LV�SDVV-

word-protected. 

,I�\RX�KDYH�HQFU\SWHG�D�ĆOH�L�H���PDGH�LW�SDVVZRUG� 

SURWHFWHG�RQ�\RXU�FRPSXWHU��\RX�FDQ�UHPRYH�ĆOH� 

HQFU\SWLRQ�E\�FKDQJLQJ�WKH�ĆOHèV�SURSHUWLHV��

Removing Encryption from a File on a PC
/RFDWH�WKH�ĆOH�IURP�ZKLFK�\RX�ZDQW�WR�UHPRYH�HQFU\SWLRQ��

5LJKW�FOLFN�RQ�WKH�ĆOH��WKHQ�FOLFN�WKH�3URSHUWLHV�OLQN�LQ�WKH�

context-menu to open a Properties window. Click the 

Advanced button. Click to uncheck the box next to Encrypt 

contents to secure data in the Advanced Attributes window. 

Click the OK button to close the Advanced Attributes win-

dow. Click the Apply button in the Properties window, then 

click the OK button. This closes the window and completes 

the encryption removal process.

Removing Encryption from a File on a Mac
5LJKW�FOLFN�RQ�WKH�ĆOH�E\�KLWWLQJ�&RQWURO���&OLFN�� 

Choose Get Info from the list that opens. Make sure  

the locked box is unchecked to ensure there is no  

SDVVZRUG�SURWHFWLRQ�RQ�\RXU�ĆOH��

Embedding Fonts
The document needs to contain certain information so the 

printer knows how to render your book’s typeface. In some 

ZRUG�SURFHVVLQJ�VRIWZDUH�\RX�QHHG�WR�VSHFLĆFDOO\�LQGLFDWH�

that you want to embed your fonts in the document so that 

WKH\�UHQGHU�SURSHUO\�LQ�\RXU�ĆOH��7KDQNIXOO\��PRVW�ZRUG�

processing software makes this easy to do. 

Word for Mac does not have a font embedding option, so if 

you are using this program you should be able to save to PDF 

without formatting issues, provided your PDF software is set 

to the correct trim size (we’ll go over that later).

GENERATING A PRINT-READY FILE
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Embedding Fonts Using Word on a PC
)URP�ZLWKLQ�D�:RUG�GRFXPHQW��FOLFN�WKH�2IĆFH�EXWWRQ�LQ�WKH�WRS�OHIW�FRUQHU�RI�WKH� 

screen. At the bottom of the dialog box that opens, click the Word Options button.  

Or, click File and then click Options.

Inside the Options section you will see the dialog box below. In the last section on the screen, 

VHOHFW�ç(PEHG�IRQWV�LQ�WKH�ĆOHè�E\�FKHFNLQJ�WKH�ER[��/HDYH�WKH�RWKHU�WZR�ER[HV�XQFKHFNHG��&OLFN�

2.��7KH�ĆOH�ZLOO�QRZ�VDYH�ZLWK�IRQWV�HPEHGGHG�

GENERATING A PRINT-READY FILE

19 The Barnes & Noble Press Print Platform Formatting Guide



 Note: When using Microsoft Word, there are a number 

RI�PHWKRGV�IRU�FUHDWLQJ�D�3')�ĆOH��*HQHUDOO\�VSHDNLQJ��

they will produce the same result, but following the steps 

below will ensure your PDF is print-ready for the Barnes 

& Noble Press print platform if you choose to convert it. 

Setting PDF Dimensions
Before saving as a PDF, you must double-check that your 

Word document is going to save as a PDF with your de-

sired paper size.  

Setting PDF Dimensions Using Microsoft Word on a PC 
)URP� WKH� 2IĆFH� EXWWRQ� LQ� WKH� WRS� OHIW� KRYHU� RYHU� 3ULQW�� DQG� WKHQ� FKRRVH� 3ULQW� 3UHYLHZ�� 

From the Page Setup section, click on the Size section to see the drop down menu. Then 

choose More Paper Sizes... Enter your desired trim size in the width and height sections. 

SAVING A FILE AS A PDF (OPTIONAL)
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Setting PDF Dimensions Using Microsoft Word on a Mac 
On the top navigation bar, click File ¤ Print to open the Print dialogue box.  

Click on Page Setup… at the bottom left. 

Click on Paper Size and then  

Manage Custom Sizes…

Enter the Paper Size for the PDF  

you are creating.



File ¤ Save As

Using Microsoft Word on a PC 
On the top navigation bar choose File ¤ Save As and you will open the below dialog box. 

Choose PDF as the Save as type. Click on Options… and in the choices below PDF Options, 

FKHFN�WKH�ER[�WKDW�UHDGV�ê,62���������FRPSOLDQW��3')�$��ë��$IWHU�VDYLQJ�RSHQ�WKH�3')�DQG�

check each page to make sure it looks like you expected it to. 

Using Microsoft Word on a Mac 
From the top navigation bar, choose File, then Save As. Under Format, choose PDF. You can 

UHQDPH�\RXU�ĆOH�LQ�WKH�6DYH�$V�ER[��2SHQ�WKH�3')�DQG�FKHFN�HDFK�SDJH�WR�PDNH�VXUH�LW�ORRNV�

like you expect it to. 

SAVING A FILE AS A PDF (OPTIONAL)
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Use this checklist to ensure your PDF or MS Word file is ready for publication.

T Text has been spellchecked and proofread.

T Text formatting is complete.

  o Spacing is controlled by paragraph styles and page breaks, not by    

  spaces, tabs, or hard returns.

  o Paper size has been set according to your desired trim size.

� � R� 2XWVLGH�PDUJLQV�DUH�VHW�WR�����ë�RU�D�VLPLODU�GLVWDQFH�DQG�LQVLGH�PDUJLQV�

� � � DUH�VHW�WR����ë�

  o No crop marks appear.

T Images are ready.

  o You own all the rights to the images in the book.

  o All images are 300 DPI or higher.

  o All images have been saved in an analog mode if you used Photoshop 

   or Illustrator. 

  o No images are encrypted.

T Pagination is ready.

  o Odd-numbered pages appear on the right, even-numbered pages on 

   the left.

  o If front matter uses a different numbering scheme, that numbering is 

   consistent and correct.

  o Elements such as prefaces, forewords, and chapters all begin on 

   odd-numbered pages.

T� 7KH�ĆOH�LV�HLWKHU�D�3')�RU�DQ�06�:RUG�ĆOH�

  o  The paper size (selected page dimensions) matches a trim size supported by 

WKHb%DUQHV�	�1REOH�3UHVV�SULQW�SODWIRUP��

� � R� )RQWV�DUH�HPEHGGHG�LQ�WKH�ĆOH��

  o Encryption is turned off.

PRE-PUBLICATION CHECKLIST
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important to make sure that it accurately represents your 

book. The following includes helpful tips and instructions to 

ensure your cover turns out the way you want it to, while 

being a print-ready PDF.

A Print-Ready PDF Cover

includes front, back, and spine, or two elements (front and 

be combined on the Barnes & Noble Press print platform 

into a single cover. If you’re not using one of our cover tem-

plates, the cover formatting instructions vary a bit depend-

ing on the type of cover you choose: Paperback, Hardcover 

with Dust Jacket, and Hardcover with Printed Case.

Front and Back Covers
Every book cover is different, but almost all include the title 

and author’s name. It’s also common to see a subtitle, or 

endorsement quote when applicable. Expressing the tone of 

the mood of your book, or an image that represents the 

storyline or theme. 

The back cover can include a variety of items, depending 

on your preference. Most include a book synopsis or 

endorsements, a brief about-line of the author (if not 

included inside the book), and a barcode or other pricing 

notes if applicable. You can also include your website, book 

specs and any other information you wish to share. For print 

books for sale, if you don’t have an ISBN and receive one 

from Barnes & Noble Press, we add a barcode to the bottom 

right-hand side of your back cover, so be sure not to put 

important content in this area. If you have your own barcode 

and place it on the cover, it will appear in your digital cover 

proof. If your print book is for personal use, you will see a 

white box on the bottom right-hand corner of your book 

where a barcode will go. This barcode will appear on your 

The Spine
Similar to the front cover, the spine almost always includes 

the title and author’s name. Your spine will need to be a 

directly on the Barnes & Noble Press print platform as a 

color of your spine and the text you would like to include.

For books with a page count of 50 pages or fewer, the spine 

is too small to include any text without it being cramped and 

hard to read.

Assembling a Print-Ready Cover

spine size of your book based on a variety of factors, and 

prompt you to pick from three spine colors and to add your 

Title and Author Name, if desired. The platform stitches the 

front and back covers to the spine to make a complete cover 

for you to preview and approve.

Helpful Tips & Templates 
To make your book formatting process easier, for single 

when you reach the Book Cover upload page. These tips will 

If you choose to create your cover using separate front and 

cover templates in the various trim sizes available for the 

Barnes & Noble Press print platform. Our templates are 

available at BNpress.com .

CREATING A COVER – SEPARATE FRONT/BACK COVER
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How to Use the Barnes & Noble Press Print 
Platform Cover Templates (Front/Back Cover 
Files)
Choose the Barnes & Noble Press print platform cover tem-

plate that matches your book’s trim size. The front and back 

cover templates work similarly. Instructions for using the 6” 

x 9” front paperback cover template follow below. 

1. Save the template under a new name before getting 

started. 

2. The page size is set appropriately at 6.125” x 9.25”. 

3. The margins are set appropriately at ZERO.  

Any image or text that appears in the blue trim  

zone may get trimmed off. 

4. The page color is set to WHITE but can be adjusted by 

going to the Page Layout tab and using the  

Choose Page Color option. If you change a background 

then to 

Word Options in the bottom right. Choose the Display 

option, then Printing Options, and then select the box 

Print Background Colors and Images. 

5. You can adjust the font and font size for the book de-

scription and author bio. 

6. Insert an image into the image area by selecting the 

Insert Image/Photo option. 

 

 a. Choose an image of at least 300 DPI from 

   your computer.

 b. Adjust the placement of the image by clicking just   

outside of the image. 

 c. Increase, decrease, or move around the dotted   

 blue box for desired placement of image. 

 d. Adjust image size by clicking on the image. 

7. You can add additional text boxes for more text. 

8. Before saving as a PDF, delete the template Instructions 

and the Blue Trim Lines by clicking on them and hitting 

delete. You should now have only one page – your front 

cover image in this case – to save as a PDF. 

9. Embed your fonts. See page 18 for embedding instructions. 

10. 

about printing outside the margins. 

Cover File Properties 
• Trim size refers to your chosen interior page size. 

• Your Cover Page Size will be different from your 

 interior page size. The cover size is larger than the  

interior page size because it will be trimmed after printing. 

Your Cover Page Size will vary in dimensions depending on 

the type of cover you are creating.

CREATING A COVER – SEPARATE FRONT/BACK COVER

24      The Barnes & Noble Press Print Platform Formatting Guide

strongly suggest using one of our cover templates to make cover creation 

easier. Our front and back cover templates are available at  BNpress.com .

Cover Page Size

 Paperback Hardcover with Hardcover with
Trim Size cover size Dust Jacket size Printed Case size                      
5” x 8” 5.13” x 8.25”   
5.5” x 8.5” 5.63” x 8.75” 6.19“ x 9” 6.45” x 10“                                     
6” x 9” 6.13” x 9.25”  6.69” x 9.5”  6.94” x 10.5”                                      
7.5” x 9.25” 7.63” x 9.5”                                     
7” x 10” 7.13” x 10.25”   7.94” x 11.5”                                      
8” x 10” 8.13” x 10.25”   8.94” x 11.5”                                      
8.5” x 8.5” 8.63” x 8.75”                              
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ï� Margins�ZLOO�EH�VHW�DW�=(52�IRU�\RXU�FRYHU�ĆOHV�EXW�\RX�QHHG�WR�DOORZ�URRP�IRU�WULPPLQJ��7R�PDNH�D�VSHFLĆF�ERRN�VL]H��

the printer cuts off the edges of the paper. If your content is too close to those edges, it can get cut off. You will want 

\RXU�FRYHU�LPDJH�RU�GHVLJQ�WR�H[WHQG�DOO�WKH�ZD\�WR�WKH�WULPPLQJ�]RQH�VR�WKDW�\RXU�LPDJHV�DQG�GHVLJQ�FRPSOHWHO\�ĆOO�

the page. However, if you don’t want aspects of an image cut off, don’t put them on the very edge of the page in the 

trimming zone. If you keep your document in Word, you must also go through these steps to ensure that your MS 

:RUG�GRF�VDYHV�DV�D�SULQW�UHDG\�ĆOH�WR�XVH�RQ�RXU�SODWIRUP�

These are the Trim Zones for each format:

CREATING A COVER – SEPARATE FRONT/BACK COVER
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7RS������ë�

%RWWRP������ë

Left: 0

Right: 0.13”

Front cover

Paperback Cover

7RS������ë

%RWWRP������ë

Left: 0.13”

Right: 0 

Back cover

7RS������ë

%RWWRP������ë

Left: 0.25” (fold zone)

Right: 0 

Back cover

7RS������ë�

%RWWRP������ë

Left: 0

Right: 0.25” (fold zone)

Front cover

Hardcover with 
Dust Jacket 

7RS������ë

%RWWRP������ë

Left: 0.63”

Right: 0.5” (cover hinge)

Back cover

7RS������ë�

%RWWRP������ë

Left: 0.5” (cover hinge)

Right: 0.63” 

Front cover

Hardcover with 
Printed Case
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Measurements
If you choose not to use a Barnes & Noble Press print plat-

form cover template, the measurements of your front and 

EDFN�FRYHU�ĆOHV�DUH�DV�IROORZV��

Paperback Cover
Set your cover paper size (front and back) according to your 

chosen trim size using the below chart. Margins should be 

set to 0. Allow for bleed room (trim zone) according to the 

chart below so that important (i.e., not your cover back-

ground design) images and text don’t get cut off. 

Paperback Cover  
Use the same trim size you chose for your interior.

Paper Size  

 Interior Trim Size Cover Size (front/back)         

� �ë�[��ë� ����ë�[�����ë��������������������������������������

� ���ë�[����ë� ����ë�[�����ë�����������������������������

� �ë�[��ë� ����ë�[�����ë��������������������������������

� ���ë�[�����ë� ����ë�[����ë��������������������������������

� �ë�[���ë� ����ë�[������ë�����������������������������

� �ë�[���ë� ����ë�[������ë���������������������������

� ���ë�[����ë� ����ë�[�����ë��������������������������������

 
Trim Zone (area that might get trimmed off) 

 Front Cover Back Cover                                   

� 7RS������ë� 7RS������ë                                     

� %RWWRP������ë� %RWWRP������ë�������������������������������

� /HIW���� /HIW������ë�����������������������������������

� 5LJKW������ë� 5LJKW������������������������������������������

 Gutter: 0 Gutter: 0                                     

 Mirror Margins: No Mirror Margins: No                    

Hardcover with Dust Jacket
Dust Jacket covers are the most complicated covers to layout 

without a template. We strongly recommend using a template 

WR�HQVXUH�WKDW�WKH�ĆQDO�OD\RXW�LV�FRUUHFW��7KH�%DUQHV�	�1REOH�

Press print platform offers two trim sizes for Hardcover with 

'XVW�-DFNHW�����ë�[����ë�DQG��ë�[���ë�)RU�'XVW�-DFNHWV��ZH�ZLOO�

JHQHUDWH�ZKLWH�IURQW�DQG�EDFN�ćDSV�DQG�ZLOO�VWLWFK�WKHVH�WR�

WKH�IURQW�DQG�EDFN�FRYHUV��:H�KRSH�WR�RIIHU�WH[W�RQ�WKH�ćDSV�

very soon. 

Set your cover paper size according to your chosen trim size 

using the below chart. Margins should be set to 0. Allow for 

bleed room (trim zone) according to the chart so that impor-

tant (i.e., not your cover background design) images and text 

don’t get cut off. 

Hardcover with Dust Jacket 
Use the same trim size you chose for your interior

Paper Size  

 Interior Trim Size Cover Size (front/back)         

� ���ë�[����ë� ����ë�[��ë��������������������������������������

� �ë�[��ë� ����ë�[����ë����������������������������������

Trim Zone (area that might get trimmed off) 

 Front Cover Back Cover                                   

� 7RS������ë� 7RS������ë������������������������������������

� %RWWRP������ë� %RWWRP������ë����������������������������

� /HIW���� /HIW������ë��IROG�]RQH�������������������

� 5LJKW������ë��IROG�]RQH�� 5LJKW�����������������������������������������

 Gutter: 0 Gutter: 0                                    

 Mirror Margins: No Mirror Margins: No                  

FILE PREPARATION QUICK GUIDES – FRONT/BACK COVER
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Setting Page Sizes
Go to File from the top navigation bar, then click on Page 

Setup from the drop down menu. When the dialog box pops 

up, choose Manage Custom Sizes… from the Paper Size 

section. 

When the second dialog box pops up, click on the + sign to 

add your new custom trim size. Type in your desired Width 

and Height in the Paper Size section and then click OK. Click 

OK again to set your new custom trim  

size for your book. 

 

Creating Page Breaks
Go to Insert from the top navigation bar and then choose 

which type of break you want to insert e.g., Page Break. 

Setting Up Running Headers and Footers
In documents based on a Word Processing Template, running 

heads are the default until a Section Break is inserted.

To view the header, hover the pointer at the top of the page 

until the Header box appears. In Pages, you see headers 

and footers by choosing View -> Show layer. To see them in 

Pages for iOS, tap the Tools icon (a wrench) and tap Docu-

ment Setup.

The Header is there. Hover the cursor over the top of the 

page until you see a Header box. Or, turn on Show Layout 

(View > Show Layout).

In documents based on a Mac Pages Layout Template, you 

must turn on headers and footer explicitly. Hover near the 

top of the page or choose Show Layout to see the current 

settings for headers and footers.

Embedding Fonts 
If you’re using Pages, you don’t have to worry about embed-

ding fonts at this juncture. Once you save your document as 

a PDF, open the PDF in Preview, and then save it again. Your 

document is now saved with fonts embedded. It’s that easy.

Saving a File as a PDF
Open the File menu, select Save As and choose PDF from 

the Format drop-down menu. Click Save. Open the PDF and 

check each page to make sure it looks like you expect it to. 

APPENDIX A. Instructions for Authors Using Pages for Mac or Pages for iOS
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Hardcover with Printed Case
Set the page size according to your chosen trim size using 

WKH�EHORZ�FKDUW��0DUJLQV�VKRXOG�EH�VHW�WR����$OORZbIRU�EOHHG�

room (trim zone) according the chart so that important (i.e., 

not your cover background design) images and text don’t get 

cut off. 

Hardcover with Printed Case 
Use the same trim size you chose for your interior.

Paper Size  

 Interior Trim Size Cover Size (front/back)          

� �ë�[��ë� 1�$����������������������������������������������������

� ���ë�[����ë� ����ë�[���ë������������������������������������

� �ë�[��ë� ����ë�[�����ë��������������������������������

� �ë�[���ë� ����ë�[�����ë���������������������������������

� �ë�[���ë� ����ë�[�����ë���������������������������������

Trim Zone (area that might get trimmed off) 

 Front Cover Back Cover                                  

� 7RS������ë� 7RS������ë�����������������������������������

�� %RWWRP������ë� %RWWRP������ë�����������������������������

�� /HIW�����ë��FRYHU�KLQJH�� /HIW������ë����������������������������������

�� 5LJKW������ë� 5LJKW�����ë��FRYHU�KLQJH���������������

  Gutter: 0 Gutter: 0                                      

  Mirror Margins: No Mirror Margins: No                  

Using Microsoft Word to Create a Front  
or Back Cover File 
Click the Page Layout tab and then choose Size to adjust 

the document size. You will most likely need to make this a 

custom size document. Under the Paper tab, input your pa-

per size based on the preceding charts. Your cover margins 

ZLOO�EH�VHW�WR����ë��EXW�NQRZ�WKDW�\RX�QHHG�WR�DOORZ�URRP�IRU�

trimming when the cover is cut. 

Then, without moving the typing cursor, click Insert in the 

menu bar, then click Photo or Picture ¤ Picture from File 

to insert your cover image. Make sure your cover fonts are 

embedded (see page 18 for more details).  

Click Save As a PDF. 

Layout and Images
It’s important to remember that the trim zone might be cut 

off during printing, so be sure to keep your images and text 

within the trim size measurements, keeping them out of 

the trim zone, if you don’t want them to get cut off. Finally, 

double check to make sure any images used meet the same 

print resolution requirements as the manuscript. (See page 

14 for more information about Images.)

FILE PREPARATION QUICK GUIDES – FRONT/BACK COVER
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